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Updated 24/01/2012

Purpose of the release notes

This document provides a summary of changes and known bugs since the first full release of Urban
Developer (Urban Developer v1.0.0). If you are after information about Urban Developer features and
what it can be used for, please refer to the www.ewater.com.au web site.

About Urban Developer v1.1

Urban Developer provides quantitative assessment of the urban water cycle from the single allotment
to the suburb scale.

Urban Developer adopts a whole of systems perspective that considers the urban water cycle in an
integrated fashion, to include rainfall, stormwater, water supply and wastewater in a single modelling
framework. Urban Developer is aimed at building capacity for better decision-making, management
and regulation of urban land-use change and renewal.

System Requirements

The Software may only be installed and used on personal computer equipment, including a server or
individual computer, which meets or exceeds the following minimum system requirements:

a) An Intel Pentium IV, 2.66 GHz processor or faster

b) 32-bit Windows XP or Windows 7, or 64-bhit Windows 7

¢) A minimum screen resolution of 1024 x 768 at 16-bit colours (preferably 32-hit)

d) Atleast 1 GB of free hard drive space

e) A minimum of 4 GB of RAM (32-bit), 6 GB is recommended (32-bit and 64-bit); and
f)  Access to the internet

Prerequisite software (Mandatory)

e .NET Framework 4.0

You can only have one version of Urban Developer running at a time. The soft lock key version can
only be run locally and cannot be installed on a server or accessed remotely.

Local administrator rights may be required for installation and use of the software

What's new in Urban Developer v1.1

New features

Support for suburb scale projects

Urban Developer now contains 6 new node models and 2 new link models that support the
representation of suburb scale networks, including Gutter Entry Pits, Pipe and Channel Link Routing,
and MUSIC Catchment nodes. Also included are new network statistics that provide a summary of
network wide dynamics.


http://www.ewater.com.au/
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Improved reporting - Network Statistics

Urban Developer now has the powerful ability to calculate statistics across an entire network /
scenario. This is extremely beneficial for gaining easy access to high level summary statistics, for
instance: total mains water usage, total tank usage, total runoff, total wastewater generation etc. This
feature is available for both Observed Analysis and ARR Design Rainfall runs. Network Statistics will
be calculated for all items with Statistics recording turned on in the Project Explorer, and can be
accessed after a run has completed through the Tools menu. Statistics are displayed in a separate
Network Statistics panel.

Improved reporting - Network Time Series

Urban Developer can now export total time series across the entire network / scenario and is
particularly useful for up scaling the results from urban models into eWater Source models. Like the
network statistics, this is aimed at gaining easy access to high level summaries, for instance: time
series of total mains water usage, total tank usage, total wastewater generation etc. Network Time
Series are calculated for all items with Time Series recording turned on in the Project Explorer, and
can be accessed after a run has completed through the Tools menu.

Improved reporting — Daily and Event Peak Flows

Urban Developer now calculates daily and event peak flows for assessment of the modelled system
against design criteria. For example, this can be used for sizing drainage infrastructure, assessing the
effectiveness of runoff management strategies (e.g. adding retention / detention tanks), or examining
whether changes to runoff from a proposed development due to changes in pervious / impervious
areas meet council peak runoff targets.

New node model — MUSIC Catchment Nodes (quantity only)

Urban Developer now includes MUSIC catchments nodes. The introduction of these water quantity
nodes provide an important suburb-scale capability. Through the use of these nodes, Urban
Developer generates runoff for agricultural, forest, urban or user-defined catchments.

New node model — Gutter Entry Pits

Urban Developer now includes Gutter Entry Pit nodes. Gutter entry pits are a common element of any
piped urban drainage system and an important part of modeling at the suburb scale. These are now
included as a separate node providing an important link between surface and piped flows.

New node model — Retention / Detention Tanks

Urban Developer now includes Retention / Detention tank nodes. Retention and detention tanks are
an important feature for managing stormwater. Typically, in the form of an underground tank or gravel-
filled trench, they provide temporary storage of water before it is discharge or infiltrated into the
underlying soil. Runoff from surfaces, such as roofs or overflow from structures such as rainwater
tanks, can now be directed to a retention or detention node.

New link models - Link Routing (Pipe and Channel)

Urban Developer now includes representation of flow along different watercourses, such as pipes,
open channels and surface overflow paths. Links can now be configured to represent changes in flow
present at the suburb scale, using either lag-shift or lumped routing models.
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Memory usage estimate for recording

The Project Explorer now includes the ability to estimate the amount of memory likely to be used in
the simulation, based on the time series recordings you have turned on. This feature provides an
indication before the simulation of whether or not the run is likely to encounter memory or
performance issues.

Main changes

Parameter Recording

The recording of node parameters has now been split up into Time Series, Event Peak Flow, Daily
Peak Flow, and Statistics, allowing flexible control over node recording. Urban Developer also
includes the ability to record either at subdaily, daily, or monthly time steps, depending upon the
resolution at which the modeller is interested. The latter can be set within the Tools | Options menu.

Critical Event for Design Rainfall runs
For ARR Design Rainfall runs, node statistics have been expanded to allow easy identification of the
critical rainfall event.

Updated User Guide and Help
User Guide and Help content have been updated to reflect changes to Urban Developer since v1.0.

Updated node connection rules
The node connection rules have been updated to allow for the addition of new node models. As
before, only the valid connection points will display when connecting two nodes together.

Known Issues

[CUT-1280] Recordings incorrect when climate data changed after first run

[CUT-1252] Minor water balance error for pipe/channel routing when using lumped scheme
[CUT-1169] Network does not run correctly after previous run was stopped manually

[CUT-1153] Incorrect circular dependency in subnet for any node with more than one connection point
[CUT-1152] Circular dependency when tank demand and spill (or detention) are connected to subnet
[CUT-1140] Small discrepancy in Mains Supply and Water Use rates when using long rainfall file
[CUT-1077] Property panel text and tables not resized correctly after changing display settings
[CUT-1074] Unsaved node notes lost when panel loses focus

[CUT-992] Project Explorer does not show a new scenario when it is created

[CUT-844] Non admin users do not see the “My Urban Developer” folder by default

[CUT-819] A styled node cannot be edited without changing all other instances of the style
[CUT-816] Large amounts of sub daily data can cause performance issues

[CUT-775] Small memory leak occurs when running, loading and closing a project multiple times
[CUT-652] Exporting run results writes some non ASCII characters to CSV file

[CUT-629] User cannot add more than one average daily end use

[CUT-589] Start and end date times of simulation are not shown in the user interface

[CUT-563] Urban Developer installer is not digitally signed

[CUT-547] Running form shows Complete when the Run was prevented by an error

[CUT-514] Application doesn't remember previous positions of windows
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Bug Fixes

15/12/2011 Build 1.1.0.140

[CUT-1263] Fixed node property panel does not accept changes when same node is clicked
[CUT-1262] Fixed node statistics showing "Number of runoff days: 0" when statistics not recorded
[CUT-1261] Fixed node statistics "Divide by zero" exception when tank demand is not recorded
[CUT-1258] Reduced minor water balance error for pipe/channel routing when using lumped scheme
[CUT-1253] Fixed Project/Scenario disappear in Project Explorer when last node on canvas deleted
[CUT-1250] Fixed node stats generates exception for Water Use

[CUT-1239] Fixed unhandled null exception in Tools menu when no canvas is open

[CUT-1238] Reduced project file size by removing daily rainfall bts file

[CUT-1237] Reduced project file size by not including temporary ShadowFiles

[CUT-1233] Fixed channel and lag shift properties panel are blank

[CUT-1232] Fixed inverted and non-inverted hyetographs no longer shown as a histogram
[CUT-1231] Fixed large upwelling in Sag Gutter Entry Pit when downstream link is surface overflow
[CUT-1230] Fixed daisy chaining of roof nodes generating extremely large inflows

[CUT-1229] Fixed error in discharge calculation for tank routing

[CUT-1227] Fixed the right mouse menu on a node shows "Graph" even no graphs to plot
[CUT-1154] Fixed subnet only records partial time series for wastewater inflows

[CUT-1147] Fixed water use model creating wastewater even though no water is being supplied
[CUT-1141] Fixed link results always recorded even when set not to in the project manager
[CUT-1137] Fixed unhandled exception when double-clicking above schematic canvas

[CUT-1132] Fixed project does not run because root scenario not selected as the active scenario
[CUT-1130] Fixed design rainfall storm duration list not persisted after NHibernate updated
[CUT-1092] Fixed form tabs not sequential

[CUT-1031] Fixed context sensitive help missing from node palette

[CUT-948] Removed upper limit on catchment node surface area

[CUT-754] Fixed water use behavioural indoor use priorities cannot be entered out of order

11/10/2011 Build 1.0.1.9

[CUT-1168] Fixed water balance errors when all water use priorities are set to "Don't Supply"
[CUT-1167] Updated node connection rules for subnetworks

[CUT-1147] Fixed water use model creates wastewater when no water is supplied
[CUT-1138] Fixed tank model infinite loop when top up is off and retention zone depth > 0.3
[CUT-1136] Fixed BoM pluviograph climate data read as 1.0mm/6min instead of 0.1mm/6min
[CUT-1109] Fixed project retaining climate data after the data has been deleted

[CUT-552] Fixed dialog box popups on wrong screen for dual screen configurations.

17/06/2011 Build 1.0.0.107

[CUT-1103] Fixed start up screen crash when application cannot access internet connection
[CUT-1102] Fixed only rainfall shows for Line / Hyetograph graph option when plotting demand
[CUT-1099] Disabled subnet copy in the Project Explorer

[CUT-1098] Fixed null reference exception when searching for non-existent tank outside subnet
[CUT-1096] Fixed redrawn subnet link makes Project Explorer link disappear when project reloaded


http://jira.toolkit.net.au/browse/CUT-1239
http://jira.toolkit.net.au/browse/CUT-1238
http://jira.toolkit.net.au/browse/CUT-1237
http://jira.toolkit.net.au/browse/CUT-1233
http://jira.toolkit.net.au/browse/CUT-1232
http://jira.toolkit.net.au/browse/CUT-1231
http://jira.toolkit.net.au/browse/CUT-1230
http://jira.toolkit.net.au/browse/CUT-1102
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[CUT-1094] Fixed null exception when making a newly created sampled behavioural water use file
[CUT-1093] Fixed wrong warning for out of sequence average daily indoor supply priority
[CUT-1090] Permit statistics to be calculated for Design Rainfall

[CUT-1089] Updated recommended values for a Tank node

[CUT-1088] Fixed link still in Project Explorer when deleted on canvas

[CUT-1087] Fixed tab for a deleted subnet shows up on reloading

[CUT-1083] Fixed water use node in a subnet has incorrect Houselndex

[CUT-1082] Fixed link rows have no data when project is first created and saved then run
[CUT-1080] Fixed node with multiple downlinks loses all downlinks when one is deleted
[CUT-1079] Fixed duplicate link rows appear in project explorer when project first saved
[CUT-1076] Fixed water use mains supply not failing over when set to priority 3 or greater
[CUT-1075] Fixed clicking a node can generate warning from another nodes invalid parameter
[CUT-1073] Fixed climate configuration button inaccessible after leaving subnet scenario
[CUT-1070] Resaved sample projects to update the database version

[CUT-1069] Fixed supernet nodes displaying the class name of their generators on the node icon
[CUT-1064] Fixed style properties area is not cleared between projects

[CUT-1062] Fixed Subnetwork styles not named as “Subnetwork # Style #’

[CUT-1060] Updated recommended and absolute max/min parameter values and info blurbs
[CUT-1058] Fixed WasteWater node not passing all water from inside to outside a subnetwork
[CUT-1056] Fixed “All Layers” button not working in Layer Manager

[CUT-1054] Fixed incorrect statistics due to the wrong name used in the network hierarchy
[CUT-1053] Fixed right hand side of Behavioural water use table cut off

[CUT-1032] Fixed multiple error messages for water use “% must add up to 100%”

[CUT-1048] Changed scenario tab so that tab name is only changed with a double click
[CUT-1047] Fixed double clicking title bar or maximising main window does not resize child windows
[CUT-1028] Fixed statistics panel toolbar & view menu buttons throwing unhandled exception
[CUT-1026] Fixed tank inflow has a demand time step when no demand is connected
[CUT-1024] Removed Grid Settings option from right click node menu

[CUT-1023] Fixed unhandled exception when selecting statistics from link right click menu
[CUT-1022] Created separate splash and startup screens

[CUT-1021] Fixed unhandled exception when attempting to edit a copied subnetwork style
[CUT-1020] Fixed can't copy a saved scenario containing a subnet with links to supernet nodes
[CUT-1019] Fixed deleted scenario not decrementing the style usage count

[CUT-1018] Changed “urbanCycle” to “Urban Developer” in sample diurnal pattern file
[CUT-1017] Removed "Connection" item from link right click menu

[CUT-1016] Fixed priority drop down boxes in the average daily water use property panel
[CUT-1015] Fixed pan position on canvas resets when dragged node released

[CUT-1008] Added confirmation when deleting subnetwork and if subnetwork tab is still open
[CUT-1007] Changed colours of link types

[CUT-1006] Fixed trickle top up algorithm

[CUT-1005] Created tooltip for Configure button on Climate Toolbar called “Configure”
[CUT-1004] Changed names of Greywater, Blackwater, Wastewater, Rainwater and Stormwater
[CUT-1003] Added acknowledgements to About form

[CUT-1001] Added new statistics icon to View Menu

[CUT-1000] Fixed tooltip for Show All toolbar button

[CUT-999] Fixed first flush algorithm

[CUT-997] Fixed cannot record data from subnet embedded in another subnet

[CUT-996] Created a daily log file in the “My Urban Developer” folder

[CUT-995] Fixed cannot change soil properties after selecting Edit

[CUT-994] Disable occupants if Behavioural Water Use and Sampled Appliances have been selected
[CUT-993] Changed Chart Settings and New Project icons

[CUT-991] Restricted link routing properties panel to lag routing

[CUT-988] Fixed style deletion warning appearing only once
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[CUT-987] Allow roof node properties panel to have a zero roof area

[CUT-990] Limited tab colours in Tools | Options menu to 3

[CUT-975] Changed swale node absolute and recommended ranges

[CUT-974] Changed link parameter ranges

[CUT-970] Limited subnetwork levels to 3 including root level

[CUT-966] Fixed cannot configure styled water use node without selecting "edit"

[CUT-964] Fixed “New Scenario” button in project explorer not working when button first clicked
[CUT-963] Fixed recorded parameters not persisted in Project Explorer

[CUT-954] Fixed cannot close scenario tabs

[CUT-938] Fixed deletion of a copied scenario with a subnet causes a Project Explorer error.
[CUT-935] Statistics results added to statistics panel

[CUT-934] Special case statistics calculated for various nodes

[CUT-923] Fixed phantom link causes errors in results

[CUT-915] Fixed x64 version of water use dll throwing AccessViolationException

[CUT-914] Completed changes to naming conventions for behavioural file handlin.
[CUT-909] Calculate and display hydrological statistics from time series

[CUT-904] Show tank spill, detention and supply output in that order

[CUT-887] Fixed plot type “Line + Hyetograph” x—axis units don't have values

[CUT-886] Fixed all dockable windows to ensure they can dock and reset

[CUT-873] x64 build used a StandardTimeSeries for improved performance

[CUT-870] Added F1 help file tags and tested help functionality

[CUT-867] Ensured that soil styles can only be created/deleted by choosing Edit

[CUT-857] Persisted applications settings to xml file in the “My Urban Developer” folder
[CUT-855] Fixed license manager locking when using user authenticated wifi

[CUT-847] Completed improvements to the sampled appliances and occupancy form
[CUT-841] Fixed auto bug report generates a SOAP exception

[CUT-834] Fixed multiple links/nodes selected in results manager when clicking a reused style
[CUT-830] Fixed water use node notes button does not appear unless properties panel very wide
[CUT-821] Fixed subdaily date time x- axis labels not clear at expanded time scales
[CUT-792] Moved "dockable windows" submenu items to the View menu root

[CUT-789] Fixed sampled behavioural water use project cannot run when emailed to other user
[CUT-784] Prevent user from renaming nodes/links to identical names

[CUT-783] Fixed terminology mismatch in graph settings dialog

[CUT-780] Diurnal pattern data saved in project file

[CUT-772] Improved Configure > Water Use > Sampled appliances, File > Export/Export to CSV
[CUT-771] Prevent entering negative probabilities in sampled appliances dialog

[CUT-768] Improved sampled appliances and occupancy form

[CUT-761] Fixed New Project / Set to Recording Defaults causes exception

[CUT-760] Installer associates an icon for udproj files

[CUT-759] Added user specified additional time to ARR so that runout time is sufficient
[CUT-694] Fixed Chart Settings min/max edit boxes rounding to nearest integer

[CUT-624] Water use node results are zeroed when configured to with ARR

[CUT-594] Fixed height of tank off take and initial depth can be larger than tank height
[CUT-521]Prevent network from running when invalid model numbers detected

[CUT-506] Completed XML file for node connection rules

[CUT-436] Create functional test for Water Use Model

[CUT-372] Changed names of inputs and outputs on subnetwork node

[CUT-371] Changed nodes names and connections points for better usability

[CUT-368] Documented connection point rules

[CUT-355] Fixed adding occupancy of a house in the probabilistic configurator

[CUT-350] Deleting a style now warns user when the style is in use

[CUT-349] Dragging a style onto a node now applys the style to that node.

[CUT-346] Suppressed drop down when clicking a style in style manager
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[CUT-339] Fixed copy scenario button in Project Explorer is not working properly
[CUT-332] Fixed exception when clicking on X icon in probabilistic config form
[CUT-307] Reviewed and corrected Style Manager Tutorial content

[CUT-259] Reset Layout button now removes "log reporter” window

[CUT-253] Reset Layout button now return the canvas to original layout
[CUT-218] Created help for probabilistic behavioural water use configurator form
[CUT-217] Validate probabilistic behavioural water for min number of houses
[CUT-179] Added ability to rename a scenario from the scenario tab

[CUT-130] Added form for changing adaptive timestep settings

[CUT-122] Fixed mouse sometimes gets trapped in the schematic editor

6/05/2011, Build 0.4.1.301

[CUT-949] Added description of 2000 m”2 limit to blurbs of Roof, Impervious and Pervious nodes
[CUT-943] Fixed broken check-box for Tank First Flush and Tank External Top-up

[CUT-939] Water use node now has the same output order as a subnetwork node

[CUT-937] Warn user when they select Design Rainfall with a water use node

[CUT-928] Fixed name field obscured when editing node name

[CUT-926] Fixed application main form opening off screen on multiple screen computers
[CUT-924] Fixed incorrect detection of a MUSIC tank

[CUT-922] Improved unnecessary scrolling in pervious node properties

[CUT-911] Fixed unable to run a non-default sampled appliances on another user's computer
[CUT-910] Fixed pervious node soil style values appear in Ul but zero when model runs
[CUT-907] Fixed receiving node producing incorrect results when connected to a demand output
[CUT-906] Fixed node and link rows show in subnet recording when ‘record none' is selected
[CUT-905] Added Ul option to ARR configuration to extend time series duration

[CUT-903] Replaced tank connection point name "Outflow" with "Detention Outflow"
[CUT-902] Created a mechanism to update dependent properties in the property panel
[CUT-901] Fixed non-sequential dates in exported Excel file

[CUT-900] Fixed visual fortran error in subnetwork example project

[CUT-897] Fixed unhandled exception with New Scenario button

[CUT-896] Fixed tile windows option not functioning

[CUT-894] Improved Ul update speed of an Urban Scenario

[CUT-891] Addressed unhandled exception when opening User Guide

[CUT-890] Fixed end ese cannot be switched on in project explorer

[CUT-889] Fixed "Subdivision Example.udproj" takes very long time to load

[CUT-888] Fixed right-click results choices differ from recording manager choices

[CUT-885] Improved water balance output files

[CUT-882] Fixed climate files not persisting in observed analysis form

[CUT-861] Fixed end use daily total is much larger than subdaily total

[CUT-860] Fixed total supply is more than the total end use for average daily water use
[CUT-859] Kill license manager zombie processes on application start

[CUT-856] Multiple instances of Urban Developer can be run at the same time

[CUT-848] Show error message when link/node changed to a name that already exists
[CUT-846] Addressed subnet scenario tabs to be shown differently to parent tab

[CUT-845] Fixed canvas moves when viewing node properties after screen has been maximised
[CUT-839] Fixed style names cannot be changed using the edit button in the property panel
[CUT-742] Active scenario/subnet names truncated in project explorer
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[CUT-661] Made improvements to start up form

[CUT-551] Allowed use of mouse wheel for canvas zoom

[CUT-291] Fixed decimals, field, input names & ranges of water use behavioural properties
[CUT-290] Fixed water use behavioural outdoor units

[CUT-282] Indoor water use “Other” connection changed to “Irrigation”

[CUT-280] Fixed decimal places of roof area properties

11/02/2011, Build 0.4.0.743

[CUT-853] Demand model code reviewed and checked for correctness.

[CUT-852] Fixed demand model generating negative numbers.

[CUT-843] Small tank volumes can cause tank level to be negative.

[CUT-842] Fixed unique node/link numbering reset to 0 when a scenario/subnet is copied.
[CUT-837] Reviewed and changed system requirements for beta release.

[CUT-836] Added new udproj file icon to installer and registry section.

[CUT-835] Fixed recorded data is wrong when reusing styles in subnets.

[CUT-832] Fixed canvas jumps when selecting nodes or links from Project Explorer.
[CUT-831] New/imported parameter sets from Sample Configurator available to projects scenarios.
[CUT-830] Fixed Water use node notes button not shown until properties panel is made very wide.
[CUT-827] Improved speed of the Copy Scenario command.

[CUT-825] Add new node icons for mains, alternative and waste water supply.

[CUT-823] Fixed canvas jumps when dragging nodes onto canvas.

[CUT-820] Re-instated the "disconnect tank from roof" option in the rainwater tank properties.
[CUT-814] Changed default daily water demands in the Water Use node.

[CUT-807] Position of run button on toolbar in correct location.

[CUT-787] Fixed 'Total Supply' graph has zero results in recording manager.

[CUT-765] Fixed wrong Water Use priority error message triggered by creating a new project.
[CUT-761] Fixed 'Set to Recording Defaults' command in Project Explorer.

[CUT-760] Make and associate an icon for udproj files.

[CUT-730] Fixed new design rainfall configuration created when project reloaded.

03/02/2011, Build 0.4.0.672

[CUT-827] Improved speed of the Copy Scenario command.

[CUT-823] Dragging nodes onto canvas after clicking on Show All button.

[CUT-813] The Show All command now shows all of a background image and bent links that extend
beyond the envelope of nodes.

[CUT-812] Property changes to models now applied without requiring a "Kill Focus" event.
[CUT-811] Correct tooltip added for observed analysis delete icon.

[CUT-810] Splash screen "recently used" project names show on single line and truncated with "...".
[CUT-804] Diurnal pattern data now loads from a default binary resource.

[CUT-803] Pervious model time constant calculation determined correctly for kinematc mode.
[CUT-802] Added prompt to save existing project when loading project from "recently used" menu.
[CUT-801] Renaming a subnet scenario now renames node in parent scenario.

[CUT-799] Added item in Help menu to Release Notes file.

[CUT-798] Right click Node Results in a subnet now works after renaming scenario.

[CUT-797] Clicking node does not select recording row in subnet.

[CUT-796] Fixed simulation very slow when a link or node name is the same as existing one. Users
now cannot create a node or kink of the same name.

[CUT-795] About screen button text changed from "OK" to "Close".

[CUT-794] Corrected terminology in Layer Manager. Changed "connections” to "links".

[CUT-792] Removed "dockable windows" submenu and moved these submenu items into View menu.


http://jira.toolkit.net.au/browse/CUT-814
http://jira.toolkit.net.au/browse/CUT-814
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[CUT-791] Fixed not able to record links in a subnet.

[CUT-790] Add View menu item for removing a background image.

[CUT-789] Fixed sampled behavioural water use config file not zipped up with project file.
[CUT-788] Drop down in Sampled Appliances configurator doesn't stay open when clicked.
[CUT-786] Behavioural Sample Configurator now shows graph for occupancy and outdoor.
[CUT-785] Prevented default config being removed from Behavioural Sampled Configurator.
[CUT-784] User no longer permitted to rename nodes and links the same as other nodes and links.
[CUT-782] All links connected to a demand now use the correct recording timebase.
[CUT-780] Diurnal pattern data now saved in a project file.

[CUT-779] Background image data now saved in project file.

[CUT-778] Added button to Observed configuration form to remove a climate input.
[CUT-776] Urban Developer prevented from running when using remote access.

24/12/2010, Build 0.4.0.538

[CUT-773] Created system test for Impervious + Tank with 6 min rainfall file.

[CUT-767] Reviewed Urban Developer user guide in accordance with the reviewing guidelines.
[CUT-764] Suppressed the splash screen when udproj file is double clicked from Windows Explorer.
[CUT-753] Removed empty error box when validating diurnal pattern file.

[CUT-752] Fixed grey water loop back to tank causing very high inflow.

[CUT-751] Changed help menu item - "User Manual" to "User Guide".

[CUT-750] Added "Check Version..." to help menu.

[CUT-749] Added license number to About form.

[CUT-748] Changed RiverSystem.Forms.exe to library to prevent Source Catchments being installed.
[CUT-747] Fixed running a restored udproj containing a subnet.

[CUT-745] Bivariate statistics display problem - could not reproduce.

[CUT-744] Created ability to view total rainfall value in graphical results viewer.

[CUT-742] Fixed scenario names truncated in Project Explorer.

[CUT-740] Removed square brackets from scenario names in scenario selector.

[CUT-736] Fixed water use results inside subnet crashing chart when hyetograph plot selected.
[CUT-735] Fixed scenario forms not destroyed when creating a new project after existing one.
[CUT-734] Completed changes to probabilistic configurator.

[CUT-733] Fixed exceedance/cumulative plots removing hyetograph option from plot type drop down.
[CUT-732] Fixed chart X scale has wrong extent for design rainfall results.

[CUT-731] Fixed chart hint button changing histograms to line plots.

[CUT-729] Fixed scenario tab click cause crash.

[CUT-728] Fixed house index not set correctly when two or more water use nodes are in network.
[CUT-727] Fixed number of houses not set correctly in subnets.

[CUT-726] Fixed missing links in project explorer upon re-opening a saved project.

[CUT-725] Fixed copying a saved Design Rainfall configuration causes nHibernate error.
[CUT-723] Fixed crashing when undocking and docking scenarios.

[CUT-722] Observed rainfall configuration not persisted for second scenario - could not reproduce.
[CUT-721] Added the project filename to main form title when working with a saved project.
[CUT-720] Fixed scenario tab renaming exception.

[CUT-719] Obfuscated the Urban Developer executable using CodeWall.

[CUT-718] Fixed Demand Model (behavioural) isn't run properly when in a subnetwork.

[CUT-716] Fixed exception when viewing design rainfall plots.

[CUT-714] Fixed can't exit without saving.

[CUT-710] Removed "View Type" from the Project Explorer as options refer to Source Catchments.
[CUT-702] Splash screen is suppressed when license form is shown.

[CUT-701] Added OLMS startup code to UrbanClusterGUIl.MainForm.

[CUT-695] Added minutes to X-axis plot grid option.

[CUT-694] Permit chart Y sxis max/min to have values less than one.
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[CUT-692] New chart always brought to front.

[CUT-691] Appended run time-stamp to series title in graph legend.

[CUT-685] Confirmed configure menu selection for water use node acts only on the active scenario.
[CUT-679] Climate data form remembers last folder.

[CUT-666] Fixed circular reference errors still present after the circular reference is deleted.
[CUT-663] Improved speed of E2ChartControl monthly statistics calculation.

[CUT-654] Fixed recording manager excel button does not export all data points using adaptive.
[CUT-634] Fixed subnet crash just before run - "simulation failure".

[CUT-621] Fixed Design Rainfall incorrect results after running same model with continuous rainfall.
[CUT-606] Fixed deselecting all layers retains ‘orphan' links.

[CUT-576] Removed water quality options in graph legend.

[CUT-566] Added support for importing BOM pluviograph climate data files.

[CUT-541] Fixed Collier Street project crashing.

[CUT-534] Created system test for Impervious + Receiving with 6 min rainfall file.

[CUT-515] Changed "Reset Layout" to "Reset All Windows" in View menu.

[CUT-513] Improved recording key icons appearance.

[CUT-512] Fixed autoscrolling of schematic editor.

[CUT-511] Fixed 'Copy Scenario' button in project explorer - previously created a new blank scenario.
[CUT-416] Added options to change the scale of model icons when zooming.

[CUT-399] Added warning when deleting styles.

[CUT-362] Fixed Water Use Model DLL crash when WaterUseUC.set file is empty.

[CUT-252] Fixed existing scenario tabs still visible when user clicks File>New>Project.

26/11/2010, Build 0.4.0.382

[CUT-706] Added ability to calculate statistics from Volume time series.
[CUT-705] Renamed chart styles to meaningful names.

[CUT-700] Added OLMS reference to UrbanClusterGUI project.

[CUT-699] Added OLMS binaries to installer.

[CUT-698] Added OLMS binaries to Subversion 3rdParty\OLMS\Urban folder.
[CUT-694] Fixed Min/max edit boxes should not round values to nearest integer.
[CUT-691] Appended run time-stamp to series title in graph legend.

[CUT-688] Created a way to convert the graphs to a daily time step.

[CUT-664] Improved circular dependency message.

[CUT-644] Altered grid settings not returning with saved and reopened project.
[CUT-574] Fixed graph type 'View Time Series' drop-down box truncating text .
[CUT-507] Updated parameter default values, ranges, errors and warnings.

25/11/2010, Build 0.4.0.323

[CUT-706] Added statistics from Volume time series.

[CUT-684] Fixed Water Use node crashes when tank supplies Shower, Laundry and Loo.
[CUT-683] Position of intermediate link points now saved upon re-opening a project.
[CUT-678] Fixed removing the scenario a subnet was created prevents recording of its contents.
[CUT-673] Fixed statistics should not be recalculated when Chart pages are switched.
[CUT-672] Fixed graph statistics not calculated.

[CUT-671] Pervious node soil properties - is it Holton or Horton?

[CUT-670] Pervious Area upper limit of 100m2 seems too low.

[CUT-669] Fixed difficulty reloading saved files.

[CUT-668] Fixed Kinematic wave equation causes crash.

[CUT-667] Improved info tabs on fields.

[CUT-662] Fixed E2ChartControl leaking large amounts of memory.

[CUT-660] Fixed water balance debug output missed out the last few dates of output.
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[CUT-659] Fixed water balance file not closed after run.

[CUT-658] Changed printing format of water balance file.

[CUT-656] Fixed broken pan function.

[CUT-651] Fixed roof node input validation.

[CUT-650] Fixed tank node properties do not match tank style properties.

[CUT-649] Defaults for models should not cause errors in the property editor.

[CUT-648] Cannot double-click an UDPROJ file to start the application.

[CUT-645] Determined meaning of 100% black water outdoor discharge.

[CUT-644] Fixed altered grid settings not returning with saved and reopened project.

[CUT-643] Fixed deleting pervious area soil style from styled nodes prevents editing other soil styles.
[CUT-642] Fixed soil styles not repeatable across different pervious nodes on the same canvas.
[CUT-638] Fixed cannot delete water user node using keyboard.

[CUT-637] Fixed exceptions on click select/zoom in/fzoom out/pan with no scenario open.
[CUT-636] Made node names editable in Project Explorer.

[CUT-633] Fixed show All button not showing all.

[CUT-632] Added active project next to active scenario on canvas status bar.

[CUT-623] Fixed incorrect latitude and longitude tooltips on design rainfall form.

[CUT-618] Fixed file access error for user manual link in help menu.

[CUT-615] Scenarios don't delete from project explorer if there are two or more containing nodes
[CUT-613] Fixed one design rainfall storm plot shows when multiple storms are run.

[CUT-612] Added scenario name to graph legend.

[CUT-610] Fixed viewing multiple charts causes an out of memory exception.

[CUT-596] Completed minor improvements to UL.

[CUT-593] Fixed scenario not deleted when pressing delete scenario button in the project explorer.
[CUT-565] Fixed existing project lost when new project created.

[CUT-558] Fixed range for impervious node maximum depression storage depth.

[CUT-553] Changed "Supply In" to “Inflow" and "Supply Out" to “Outflow”.

[CUT-515] Changed "Reset Layout" to "Reset All Windows".

[CUT-501] Confirmed that urban cycle nodes have recommended minimum/maximum values set.
[CUT-494] Fixed default property gives an error in water user node average daily demand table.
[CUT-490] Fixed splash screen remains on top of all other windows.

[CUT-489] Removed " (scenario) " appended to scenario name when renaming.

[CUT-472] Investigate water balance differences in Pond, Wetland, Swale compared to MUSIC.
[CUT-345] Fixed deletion of a scenario from Project Explorer.

[CUT-252] Fixed not all existing scenarios are removed when user clicks File>New>Project.

15/11/2010, Build 0.4.0.194

[CUT-660] Fixed water balance debug output missed out the last few dates of output.

[CUT-641] Fixed switching from probabilistic to deterministic and back overwrites configuration files.
[CUT-640] Fixed receiving/impervious icons chopped and replaced mains/alternative supply icons.
[CUT-639] Checked that all toolbar icons are 16x16 icons.

[CUT-635] Installer now associates .udproj file with Urban Developer application

[CUT-628] Checked that water balance is correct for Behavioural Water Use node.

[CUT-627] Fixed change in outdoor use not reflected in water use configuration file.

[CUT-626] Clicking a .udproj file now launches application without a splash screen.

[CUT-619] Renamed Water Use node outflow option "Other" to "Irrigation/Other".

[CUT-588] End Use recording tree nodes are now visible for non-Average Daily demands.
[CUT-559] Fixed soil properties for pervious node.

[CUT-499] Each node model's reset now sets initial values for recording.

[CUT-490] Fixed splash screen remaining on top of all other windows.
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11/11/2010, Build 0.4.0.153

[CUT-630] Record Supply Total as well as Demand Total for Behavioural Water Use.
[CUT-631] Outflows now recorded in terms of supply, not demand.

[CUT-625] Updated application icons

Tank now calculates instantaneous rate

Changed form title from "Zoom Options" to "Zoom Settings"

Daily water balance now calculated for Water Use behavioural

Splash screen always on top of the main application form except first time.

Changed calculation of spill to use the average discharge rate for the time step

10/11/2010, Build 0.4.0.120

[CUT-609] Fixed pervious area "Invalid parameter in node being edited" when not using kinematic.
[CUT-608] Further improvements to write water balance as a daily output.

[CUT-607] Created an average daily water balance output from the Demand node.

[CUT-597] Fixed Nhibernate exception when scenario deleted and new one created in Project
Explorer.

[CUT-597] Do not close application if user cancels "project save form.

8/11/2010, Build 0.4.0.102

[CUT-604] Spill output not assigned correctly in rain tank node.

[CUT-603] Scenario name no longer has name inside square braces.

[CUT-600] Scenario title no longer disappears when form undocked and redocked.
[CUT-523] Water use node simulation now shows 'closed’' when complete and not 'stop'.
[CUT-605] Water balance files now written to project folder.

5/11/2010, Build 0.4.0.77

[CUT-595] Tank now routes only during a wet time step.

[CUT-587] Water Use now validates diurnal file has the correct format.
[CUT-581] Fixed editing of sail in pervious area.

[CUT-579] Water Use Average demand now works with a user defined end use.

4/11/2010, Build 0.4.0.56

[CUT-585] Roof node "Runoff to street" renamed as "Runoff Bypassing Tank".
[CUT-584] Reversed "Supply out" and "Supply in" akas on Alternative and Mains nodes.
[CUT-583] Pervious node algorithm not matching Urban Cycle.

[CUT-582] Added correct icon to desktop shortcut in installer.

[CUT-580] Updated parameter warnings/errors for Pervious Area node.

[CUT-577] Fixed NullReferenceException when running a saved scenario with tank.
[CUT-560] Make sure percentage connected to tank cannot be greater than 100% or be negative.
[CUT-550] Added example diurnal file to installer for Water Use / Average Daily.
[CUT-382] Fixed memory corruptions in WaterUse node dIl.

[CUT-86] Completed the adaptive time-stepping engine for running nodes.

3/11/2010, Build 0.4.0.49

[CUT-572] Running period now determined correctly from environment time series.
[CUT-570] Automatic network generation now loads wrong data files.

[CUT-557] Saved project shows now shows results when run.

12



>

Urban Developer Water-

[CUT-556] Waste water model now persisted in udproj file.

[CUT-555] Changed process name from UrbanClusterGUl.exe to UrbanDeveloper.exe.
[CUT-549] Newly created nodes now appear when zoomed in or out.

[CUT-546] Water Use model in average mode now works with an adaptive time step.
[CUT-474] Updated recording manager to record duplicated contents of subnetworks.
[CUT-457] Simulation time for multiple runs with water use nodes gradually increases.

[CUT-366] Links connection points cannot be edited. They must be deleted and re-added.

Further Information

For further information please contact eWater Support on 1300 592 837 or email us at
support@ewater.com.au or visit the eWater website at www.ewater.com.au

Feedback

Any feedback on Urban Developer would be greatly appreciated. Please forward any comments,
suggestions, questions or bugs to the Urban Developer development team at
http://bugreport.ewater.com.au/

© eWater Ltd 2011
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